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Register Now!

Mesa Graphics Plotter Utility (MGPU) is distributed as shareware.  You are permitted to use it on a trial
basis for up to 30 days.  If you wish to continue using the product beyond that period, you are expected to
pay a registration fee of $25.  You are authorized to give "unregistered" copies of MGPU to interested
parties and to post "unregistered" copies on BBS's and other electronic forums, including the documenta-
tion and test files.  Any "registered" copy can be converted to an "unregistered" copy by clicking on the
"unregister" button in the "About MGPU" dialog.

Please support the shareware concept and register your copy.

Source License

A source license from Mesa Graphics for inclusion in products which do not compete with MGPU for
$100; contact Mesa Graphics directly.

Before You Start Mesa Graphics Plotter Utility

Before reading any further, if you have any doubts about what windows are, what select means, how you
drag and click with the mouse or the Macintosh user interface, please become familar with the Learning
Macintosh chapter in your  Macintosh owner's guide.  This manual assumes that you know and are com-
fortable with the basic Macintosh techniques and have used other Macintosh applications.

Depending on your experience with the Macintosh, you will want to use various parts of the manual in
various orders.

• Features of Mesa Graphics Plotter Utility discusses the features and data flow of the software,
illustrates connecting plotters, and explains the various icons.

• Using Mesa Graphics Plotter Utility shows how to start the utility  and gives examples for many
of the tasks which you'll do including plotting, scaling, and enhancing your graphics with color.

• Reference describes all of the commands and menus and gives additional information about color
and Pict documents.

• Plotters illustrates the option switches and parameters for plotters.
• Cables gives specific cable configurations for plotters and the serial connector pinouts for all

Macintoshes.
• Using NetSerial illustrates the use of the software with Shiva's NetSerial to connect plotters to

your AppleTalk network.



Features of Mesa Graphics Plotter Utility
Mesa Graphics Plotter Utility ( or MGPU for short) requires a Macintosh computer and a supported plotter with a
serial RS232C interface and the proper cable.

It plots any Pict document or Pict entry in the Clipboard as well as MacPaint documents created by any Macintosh
application.  It allows choices of pen color, pen speed, paper orientation, paper size, scaling, and specific location of
plots on the paper.

This version of Mesa Graphics Plotter Utility (MGPU) provides professional engineering fonts as well as plotter
fonts and the Macintosh bitmapped fonts.

MGPU can plot accurate engineering and architectural drawings, as well as, high quality scientific and business plots
in color.  The input can come from any Macintosh application that can save data as a Pict document, or copy data to
the clipboard, or save data as a MacPaint document.  Plotters from Apple, Houston Instruments, and Hewlett Packard
are supported as well as a variety of HPGL or DMPL compatible plotters.

The features of the utility are:

• Professional engineering fonts.

• Accurate control of output scaling.

• Flexible color interface for Pict (i.e. object oriented) and MacPaint documents..

• Fill pattern interface for Pict documents; 24 patterns available.

• Optional hidden line removal for lines obscured by rectangles, round rectangles, ovals, and circles.

• Hardware or Macintosh fonts; optional resizing for hardware fonts.

• Paper sizes A thru E supported (8 1/2 by 11 thru 36 by 48 inches).

• Three pen speeds.



Getting Graphic Data into Mesa Graphics Plotter Utility (MGPU)

Macintosh applications can generate and save graphic data in two common formats: Pict data and bitmaps.

MacDraw and MacDraft are examples of applications which generate objects which can be saved in Pict format
either directly or into Macintosh’s Clipboard.  The objects are lines, rectangles, ovals, circles, and etc.  The object
definitions are stored and may be drawn by the utility without jaggies, resulting in high quality output.

MacPaint and other paint applications are examples which generate and save bitmaps in MacPaint format.  These
bitmaps are always the same size and oriented for an 8 1/2 by 11 sheet of paper, i.e. the bitmap is 576 dots wide and
720 dots high.  Curves and lines tend to show jaggies but shaded realistic images can be created.  The utility converts
these bits to lines, but the jaggies remain.



This diagram illustrates the paths that can be taken to plot data generated by various applications with the utility.

MacProject and other older applications do not generate Pict files and do not generate a clean Pict into the Clipboard;
but their data can be cleaned up by copying it to the Clipboard, pasting it into MacDraw (or newer versions of
MacDraft) and then saving as a Pict document.  Thus, to plot data generated by these applications, copy the data in
the application to the Clipboard, Quit the application, start MacDraw, and Paste the Clipboard into MacDraw, Select
All, Copy, Paste into the Clipboard, Quit, start MGPU and paste it into MGPU. Or, in MacDraw save it as a Pict
document, start MGPU, Open Graphic…, and select the document.

MacDraw and newer versions of MacDraft can save the data as a Pict document.  Thus, save the data as a Pict docu-
ment from the application, Quit the application, start MGPU, Open Graphic…, and select the document.  Or, copy it
to the Clipboard and Paste it into MGPU.

MacPaint, FullPaint and other applications save the data as a bitmap in MacPaint format.  For these applications, save
the data as a MacPaint document, Quit the application, start MGPU, Open Graphic…, and select the document.
Although the Clipboard can be used in moving bitmaps from MacPaint, this severely restricts the color choices (i.e.
one) and is not recommended from a MacPaint type graphic.
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Equipment Needed

You need the following equipment to use MGPU, the Mesa Graphics Plotter Utility:

• A Macintosh Computer.
• A cable and a supported plotter.

Making the Connections

All plotters are driven from MGPU via the printer or modem serial port.  Use a proper cable and connect your plotter
to the Macintosh.  See the Plotter and Cable sections for specific details about your plotter and how to set its option
switches or parameters.

Before connecting any cables to the Macintosh,  turn
off the power to your Macintosh and your plotter.
After connecting the cables, power on the devices.  The
standard configuration for Macintoshes usually includes
a printer or connection to an AppleTalk network, thus
the illustration shows the plotter connected to the
modem port; however, MGPU can support a plotter
connected to the printer port.  If you do connect the
plotter to the printer port, check to make sure AppleTalk
is disabled via Chooser in the  menu.



Icons

MGPU, the Mesa Graphics Plotter Utility creates two different icons:

is the MGPU application icon.  Opening this icon will start the utility with the default parameters.

is theMGPU settings icon and contains your customized parameters such as plotter, port, page
size, etc.  Opening this icon will start MGPU with your customized parameters.

Installing on a Hard Disk

MGPU may be installed on a hard disk by copying the application icon to the hard disk.  Select the MGPU applica-
tion icon with the mouse and move it to the hard disk.  If you are not familiar with copying Macintosh documents,
see your Macintosh manual on Copying an Application to a Different Disk…



Using Mesa Graphics Plotter Utility

Getting
Started

Insert the
MGPU disk-
ette or open
the folder
where you
have copied
MGPU.

To start MGPU, select and open (or
double click on) the MGPU icon .

After whirring and clicking, the MGPU
window will appear.

This indicates that MGPU is now await-
ing your selections and commands.



Creating a Settings Document

To customize MGPU for your environment, you will
need to change various parameters such as the plotter
model, where it is connected, the default paper size,
etc.  Choose Plotter from the Settings.

Select your plotter and the port to which it is con-
nected.  Pen speed, paper orientation, and color op-
tions may also be selected.

Click OK when you are finished.



In future sessions, MGPU may be started with these
settings by saving them as a settings document, and
opening it instead of the MGPU icon.  Select Save
Settings As…

Enter a name for the document.

And select Save.



Plotting a Graphic

After starting from your Settings Document or setting the options
for your plotter, Choose Open Graphic… from the File menu

and select a document, such as
A Simp Test
and click Open.



It will appear on the screen.

Select Plot from the File menu, and the graphic
will be drawn on your plotter.

While the graphic is being plotted, the cursor
will change to a watch, and a message will
appear indicating how to cancel the plotting.



Plotting Part of a Graphic

MGPU allows part of the graphic to be selected for plotting instead of the entire graphic.

Open the sample graphic A Simp Test.

The rectangle with the handles is the selection rectangle and determines what will be plotted; only the contents of the
selection rectangle will be plotted.

The selection may be changed by using the mouse to adjust the size and location of the selection rectangle.



To change the size, select and move one of the handles (the black dots in the corners of the selection rectangle);
position the arrow over the handle, depress and hold the mouse button down, move the mouse, and release the button
when the desired size is obtained.

The selection rectangle may be moved by positioning the arrow inside the rectangle, depressing and holding the
mouse button down, moving the mouse to move the rectangle, and releasing the mouse button when the location is
correct.



Controlling the Size and Location on the Plotter

Open the sample graphic A Simp Test.  Choose Plotter Page from the Settings menu.

The ruler shows the size of the paper you have selected in the Plotter Settings; the bold marks on the ruler indicate
the maximum plotting area.

The rectangle shows where on the plotter the plotting will be done.  The contents of the selection rectangle will be
drawn into this rectangle on the plotter.

The size and position of the plot can be changed.  To change the size, click on and drag any of the handles on the
corners of the scaling rectangle.



The arrows allow this rectangle to be moved to the adjacent tile position; a beep will sound if there is not enough
room.

Click OK when you are finished adjusting the plotting area.



Scaling a Graphic

MGPU allows accurate control of scaling on the plotter.  For example, open the sample graphic A Simp Test.  Also,
choose Plotter from the Settings menu, click Apple for Model, and Small-Tall for Page Size.

Then, Choose Scaling
from the Settings menu.

Document inches are measured in 72nds and
plotter inches are measured in 1000ths.  The
scaling is controlled by these two numbers.

The automatic feature scales the selection rec-
tangle to the largest plotting area available.  In
this case, 594/72’s inches of the original graphic
will scale to 6889/1000’s inches on the plotter.

Further, the selection rectangle is 594/72nds by
792/72nds inches; the corresponding plotting
area is 6889/1000ths by 9185/1000ths inches.
The paper size (or maximum available plotting
area) is 6889/1000ths by 9350/1000ths.



For a one to one scale, enter 72 for Document
Inches, 1000 for Plotter Inches, click Manual,
click OK, and then MGPU will check your
scaling request for consistency.

In this case, the scaling will not fit and
MGPU complains with an error mes-
sage.  Click OK to continue.

Let’s examine why our request for one
to one scaling was rejected.  Our selec-
tion rectangle is 594/72nds wide and a
one to one scale means that it would
scale to (594*1000)/72
thousands; i.e. 8250/1000ths.  But our
Paper Size is only 6889/1000ths wide,
thus the selection rectangle will not fit
on the paper with one to one scaling.



We have two options, reduce the size of the
selection rectangle or reduce the scaling.
Let’s reduce the scaling to 3/4ths; i.e. one
document inch will scale to 3/4ths of an inch
on the plotter.

Enter 72 for Document Inches, 750 for
Plotter Inches, click Manual, and OK.

Choose Plotter Page
from the Settings menu
to see the plotting rec-
tangle.



Choose Scaling from the Settings menu to
see the exact numbers.

MGPU provides complete freedom in the the scaling but a common mistake is to request scaling values which will
not fit on the current paper size.  When this happens, check your numbers as illustrated by the previous example.



Enhancing Pict Documents with Color, Patterns,
                                                               and Line Types

For a demonstration of enhancing a Pict document with color, line
types and pattern changes, choose Open Graphic… from the File
menu,

and select and open the graphic to be
modified, Office Demo for this demon-
stration.

Choose Color from the Settings menu.



MGPU will display a pattern menu, a line type menu, a pen menu, and the object data.

Object Data                                                                              Pen/Color Menu

Current
Selected
Pattern Pattern Menu Line Type Menu



The pattern menu shows several patterns and the current selected pattern.  The current selected pattern may be
changed by selecting another one from the pattern menu by moving the arrow with the mouse to the desired pattern
and pressing the mouse button.

The line type menu allows the choice of six line types which are plotter dependent; 1 is always solid and 2-6 are
various line patterns (check your plotter documentation), long dash, short dash, dash dot, and etc..  The current line
type selection is highlighted and may be changed by moving the arrow to another and pressing the mouse button.

The pen/color menu shows the pen number and the assigned color with the current selected pen highlighted.  The
current pen is changed with the mouse by selecting with the arrow.  Pen number 9 (None) is always present; objects
with this pen color are not plotted on the paper.

The first two columns of the object data show what pattern and color were active when the particular object was
drawn;  the next to last column shows what pattern will be used when plotting these fill areas or what line type will
be used when plotting these lines or edges; the last column shows what color will be used when the object is plotted.

Colors may be changed for all objects, but patterns may be changed only for fill objects.  Fill patterns may be
changed to any pattern in the pattern menu.  Plotters do better on line patterns rather that shades of gray and only
“good plotter patterns” are included in the pattern menu.

Note that for text, only the color can be changed.

Next and Previous provide for scanning the object data, in groups of ten,  to locate specific entries.



At any given time, the arrow contains three attributes; the current pattern, the current line style, and the current pen/
color.  To change these current attributes, move the arrow and click on the desired attribute.

Change the current pattern.



Change the current line type.



Change the current pen/color.



To distribute these attributes to objects, move the arrow over data in the last two object data columns and click the
mouse button.  The line type, the pattern, or the color will be changed to the appropriate current attribute; a beep
indicates an illegal change has been requested.

To change color, line type or fill pattern, select one or more new attributes for the arrow, then distribute the new
attributes to the objects to be changed.

For example, distribute the current pattern,

Changed



Changed

the linetype,



and the pen/color.

Changed



Now you can make Office Demo as colorful and as varied as you like.  Change all the fill patterns and their colors.
You can have red bricks, blue waves, and green bars, or any combination you like.

When you are satisfied, click OK.

When you plot this, the plotter will automatically switch to the colors designated.  If after you see the finished plot
you’ve changed your mind about which colors and patterns you want, it’s a simple matter to enter the color window
and select new patterns and colors.

Sections "Using a Previously Defined Color Table with a Pict Graphic" and "Appending to a Current Color Table
with a Pict Graphics" in the Reference Section show how to save and reuse color definitions.



Adding Color to MacPaint

For a demonstration of adding color to a MacPaint document,
choose Open Graphic… from the File menu.

Select Airplane Etc. and select Open.



Notice that the rectangle around the document in this window also has handles.  A portion of the document may be
selected by both using the handles and manipulating the rectangle.



Click on and drag the lower right handle to enclose the graphic objects, but no text.

The graphics within this rectangle will be plotted within the plotting rectangle defined in Plotter Page or Scaling.



Choose Color from the Settings menu.

Pens with colors will appear.

Select New Color Rectangle, and a small rectangle with
a number in it appears next to the document.

The number indicates the color to be used and can be
changed by clicking on any of the pens to the right and
clicking on this number in the color rectangle.



The size of the color rectangle may be changed by using the handles in the corners, and moved to the desired loca-
tion.  Ten color rectangles may be created by selecting New Color Rectangle .

For example, move this color rectangle and stretch it to enclose the airplane.



Select pen color 2 and New Color Rectangle,



and put a color rectangle labeled 2 around the file cabinet.

This will result in a black airplane and a red file cabinet when plotted.



To change the color of an existing color rectangle,

select the new color,



and click on the number in the rectangle to be changed.



To remove an existing color rectangle, drag it outside the MacPaint page.

When OK is selected, color rectangles outside of the MacPaint page are deleted.

When Plot  is chosen from the File menu, MGPU will plot the selected graphic area and will automatically switch to
the colors designated by the color rectangles.



Color Overlays

If the desired image cannot be divided into color rectangles, color overlays can be created in MacPaint by starting
with the original image and erasing all but those parts that are to be one color and saving the result as a different
document.  Return to the original image and repeat the process for the other colors.  These MacPaint documents, one
for each color, can be plotted one after the other on the same page.  It is important that the scaling and plotting area
remain unchanged for the overlays to register properly.



Tips for Better Plotting

All of the Macintosh drawing applications (MacPaint, MacDraw, MacDraft, Cricket Graf, Chart…) use features
provided in the Macintosh for creating graphics and text on the screen. In particular, these features are provided by
Quickdraw which is implemented in the ROM inside your Mac.  This provides all developers with the same set of
tools and a well defined format for sharing data; text documents, MacPaint documents and PICT documents.  A more
detailed understanding of the underlying data types and the Quickdraw environment is helpful in fully utilizing the
Mesa Graphics Plotter Utility (MGPU).

All applications create pictures with the standard Quickdraw objects; text, lines, rectangles, rounded corner rec-
tangles, ovals, circles, arcs, polygons, regions, and bitmaps.  These objects are drawn with a pen which has text and
graphic characteristics.  The text characteristics include color, font type, font size and font style.  The graphic charac-
teristics include color, pen size (width and height) and pen pattern.

The Pict file type is the standard data format to share graphics between applications via the clipboard, the scrapbook
or a separate document (the Pict Save As… option of MacDraw and MacDraft).  When the objects of a picture are
saved in the Pict format, the pen characteristics at the time the object is drawn are included; the objects are included
in the proper order to preserve the front to back order.

When MGPU reads this Pict data, it is able to distinguish graphic objects drawn with different graphic pen character-
istics (pen size is obeyed but not used to distinguish graphic objects), text drawn in different colors and bitmaps
drawn in different colors.  It will also distinguish between edges and fill patterns.

When you create a drawing to be plotted, avoid solid patterns as most plotters cannot fill large areas evenly.  In the
drawing program, assign color if it is supported by grouping.  If color is not supported in your drawing program,
group all of the items of the same color and assign a pen pattern to them and then assign color in MGPU.  Then you
can change color for whole groups easily.



MacProject Tips

MacProject’s schedule chart draws the critical path with a thicker pen.  Paste the chart into MacDraw, select each
item in the critical path, change the pen pattern to a unique pattern, and save it in PICT format.  When you open it
with MGPU, set the color associated with this pattern to your favorite emphasis color (e.g. red); the critical path will
plot bold red and the rest will be black.  In fact, this is the default with MacProject II!

MacDraw/MacDraft Tips

With MacDraw II, just create the drawing, save it in MacDraw format,  and save another copy in PICT format for
MGPU.

For MacDraw/MacDraft, select all of the objects to be one color, group them, assign a unique pen pattern to the
group, and save it in PICT format.  When you open it with MGPU, locate this unique pen pattern and change the
color for these objects.  MGPU only supports left adjusted text with the plotter and professional fonts, thus use only
left adjusted.

How to Speed Up Plotting

MGPU draws the objects from the beginning of the file to the end; i.e. it draws the behind objects first and then the
front objects.  Because objects may overlap, each has to be processed against all of the objects drawn after it to
identify and remove the hidden parts.  Curves are especially slow since they are drawn with many very short straight
lines, and each one of these straight lines must be processed with the objects which follow it.  This hidden line
processing is computer intensive and slows the plotting.

If you do not have overlapping objects, use Controls in the Settings menu and turn off the hidden line processing and
speed up your plotting.

If you do have overlapping objects use the “bring to front” and send to back” functions of the drawing programs to
bring curves (ovals, arcs, rounded rectangles) close to the front.  The fewer objects which are drawn after curves the
better.



About Fonts

If you want your plot to look like your screen, use the Macintosh fonts option in Controls from the Settings menu.
All of your text will be the Macintosh fonts with all of the attributes supported (outline, underline, shadowed,
italic,…).

The plotter fonts are the fastest, but only horizontal plain text is supported;  any rotated text will be done with the
Macintosh fonts.

Simplex is a medium speed, single line width font which can be rotated, clipped at the edge of objects, only left
adjusted, plain or bold, and itallic are supported.  It is similar to the Geneva font.

For quality plots, Complex or Duplex is recommended;  both are supported rotated, left adjusted, plain or bold, and
itallic.  Complex is similar to New York or Times and Duplex is similar to Helvetica; both are two line width fonts
and are clipped at the edge of objects.



Selecting What to Plot

When a graphic is displayed on the screen, a selection rectangle is drawn to indicate what is currently selected for
plotting.  The graphic may be obtained via the Open Graphic… command in the File menu or via Paste from the
Edit menu.

In the screen below, the entire graphic is selected.

The selection may be changed by using the mouse to adjust the size and location of the selection rectangle.



To change the size, select and move one of the handles (the black dots in the corners of the rectangle).  Using the
mouse, position the arrow over a handle, depress and hold the mouse button down, move the mouse, and release the
button when the desired size is obtained.

The selection rectangle may be moved by positioning the arrow inside the rectangle, depressing  and holding the
mouse button down, moving the mouse to move the rectangle, and releasing the rectangle when the location is cor-
rect.

The screen below  illustrates a resizing and moving of the selection rectangle.  If this is plotted, only the file cabinet
will be drawn.



Tiling Selections

Selections may be tiled using the four tiling buttons on the right of the screen, i.e.  the boxes with arrows.  The tiling
directions are left, right, up, and down.  Tiling selects the adjacent selection (left of, right of, above, or below the
current selection) of the same size.  The new selection is required to be entirely within the displayed graphic, or it is
rejected and MGPU beeps.

Tiling allows large graphics to be broken into legible pieces, guaranteeing the preservation of scale across pages and
preventing the loss of plotting data.

This is tiled to the right from the previous display.



Icons

The MGPU  Application Software icon is used to indicate the Mesa Graphics Plotter
Utility software.

The MGPU Settings icon is used to save parameters (plotter, paper size…) for a
particular environment.  To start MGPU with the parameters saved in one of these
icons, simply open that particular icon.

Paint documents are usually identified by this icon.

Pict documents can be identified by various icons.



 Menu

About MGPU… displays a dialog box which gives the version
number, a copyright notice, address, and telephone for Mesa
Graphics, Inc.  Pressing the Option key when the About
MGPU dialog is displayed will show the amount of memory
free for applications (including MGPU) to use.



File Menu

Plot sends the selected part of the displayed graphic (or all of it) to the plotter; it
is only active when a graphic is displayed.

Create Plot File… requests a document name and then saves the plotter com-
mands into that document; it is only active when a graphic is displayed.

Open Graphic… allows a MacPaint document or a Pict document to be displayed
on the screen for plotting.  Pict documents can be directly generated by many
applications; MacDraw, MacDraft, TextTerm+Graphics…

After choosing Open Graphic…, a
dialog box will appear listing available
documents (of both types) in the folder
or disk.  Select one and it will be dis-
played.



Open Settings…allows commonly
used settings to be restored from a
previously saved settings docu-
ment.  After selecting Open Set-
tings…, a dialog box will appear
listing available documents.

If the selected Settings
document is incompatible
with the current version of
MGPU, an alert will be dis-
played, and the document
settings will not be used.



Save Settings As… allows the current
settings to be saved in a Settings document.
The file name is requested in a dialog.

New Page will send a new page request to the active plotter if it is either the
Other Houston & DMPL compatible plotters, or  Other HP & HPGL compatible plotters.
New Page will have no effect on the other plotter choices.

Quit terminates MGPU.



Edit Menu

Undo, Cut, Copy, and Clear are not valid in MGPU and are disabled unless a desk
accessory is active.

Paste displays the contents of the clipboard, if it is a Pict type, for plotting.



Settings Menu

These selections bring up additional dialogs to control parameters for the Plotter, plotting
Controls, the Plotter Page layout, Scaling, Resolution, and Color specification.



Plotter Options

These parameters control the pen speed of the plotter, the paper size/orientation, the port to which the plotter is con-
nected, and the model.

Speed controls the pen speed of the plotter.  Fast is as fast as the plotter will run, Medium is appropriate for trans-
parencies and high quality paper, and Slow is the slowest reasonable speed on the plotter.

Color determines whether pen change requests will be executed and may be On or Off; On means to change pens.

Page Size specifies the default paper size and orientation.  Early  plotters usually supported two paper sizes each with
two orientations and MGPU’s Page Size parameter reflects this (Small-Wide, Large-Wide…).  For A and B size
plotters (HP7475, DMP29…), small would choose A size and large would choose B size; for C and D size plotters
(DMP41,…), small would choose C size and large would choose D size.



Newer plotters (Houston’s DMP56, DMP61, DMP62; Hewlett Packard’s 7580’s, DraftPro, DraftMaster) support
many sizes; select Other Houston… or Other HP… for these models.  When one of these models is indicated, only
Auto-Normal and Auto-Rotated are selectable for Page Size.  Auto means that the page size is measured and sent to
MGPU by the plotter.  Normal refers to the orientation of the plot on the paper as illustrated in your plotter manual;
Rotate rotates the plot 90 degrees.  Smaller plotting areas may be specified by choosing Plotter Page from the Set-
tings Menu.

Connector specifies the port to which the plotter is connected, Modem(with the telephone) or Printer.

Model is the model number of the supported plotter.

Apple Apple Color Plotter
DMP29 Houston Instruments DMP29
DMP41/51 Houston Instruments DMP41 or DMP51
DMP42/52 Houston Instruments DMP42 or DMP52
Other Houston &… Houston Instruments DMP56, DMP61, DMP62 and all other

Houston Instruments large format plotters; also for DMPL compatible plotters.
HP7470A Hewlett Packard 7470A
HP7475A Hewlett Packard 7475A
HPColorPro Hewlett Packard 7440 ColorPro
Other HP… Hewlett Packard DraftPro, DraftMaster, 7580A, 7580B, 7585B,

7586B and all other HP large format plottes; also for HPGL compatile plotters.

The most sophisticated and powerful plotter drivers are the Other Houston… for Houston Instruments and the
Other Hp…  for Hewlett Packard.  The Other Houston…  option should work for all Houston Instruments plotters
which have a serial interface and support the DMPL language.  The Other Hp… option should work for all Hewlett
Packard plotters which have a serial interface and support the HP-GL language, with the ROtate command.   The
HP7470A does not support the ROtate command; use the HP7470A option for the HP7470A.



Controls

Controls customizes Pict plots; it does not apply to MacPaint documents.

Text Size allows the size of all but the Macintosh fonts to be adjusted.  MGPU automatically sets the size of the text,
but these non Macintosh fonts differ from the Macintosh fonts, and the spacing may not be exact.  If different sizes
are required, choose + numbers for enlarging the characters and  - numbers for decreasing.

Font selects the type of font to be used for plotting.  Macintosh chooses the normal Macintosh bitmapped fonts;
Plotter chooses the fonts built into the plotter; Simplex chooses a MGPU vector font similar to Geneva; Duplex
chooses a MGPU vector font similar to Helvetica; Complex chooses a MGPU vector font similar to New York or
Times.  The Macintosh font supports all of the text attributes available in MacDraw and other applications; size,
style, and alignment.  The plotter font uses the plotter's built in font for horizontal text and supports left adjusted text;
for rotated text, the Macintosh fonts are used.  The other fonts (Simplex, Complex, and Duplex) support approximate
size, the left alignment, plain or bold, and itallic.



A  < 1 >for Simplex/Duplex/Complex Retraces will draw plain text once and retrace once for bold, after moving
slightly to the right.   2 means to draw plain text twice, slightly shifting to the right between retraces; and draw bold
text four times, slightly shifting to the right between retraces.  Bold is always twice the retrace value; plain is the
retrace value.

Fills controls whether the filled areas in Pict files will be plotted (Yes) or ignored (No).

Bit Maps controls whether bitmaps in Pict files will be plotted (Yes) or ignored (No).

Lines controls whether lines obscured by filled objects (rectangles, round rectangles, and ovals) are drawn.  If none
of the lines falls behind a filled object, MGPU is significantly faster if No is selected.

Rects controls whether rectangle edges obscured by filled objects (rectangles, round rectangles, and ovals) are
drawn.  If none of the rectangle edges falls behind a filled object, MGPU is significantly faster if No is selected.

Rnd Rects controls whether rounded rectangle edges obscured by filled objects (rectangles, round rectangles, and
ovals) are drawn.  If none of the rounded rectangle edges falls behind a filled object, MGPU is significantly faster if
No is selected.

Ovals controls whether oval edges obscured by filled objects (rectangles, round rectangles, and ovals) are drawn.  If
none of the oval edges falls behind a filled object, MGPU is significantly faster if No is selected.

Arcs controls whether arc edges obscured by filled objects (rectangles, round rectangles, and ovals) are drawn.  If
none of the arc edges falls behind a filled object, MGPU is significantly faster if No is selected.

Polygons controls whether polygon edges obscured by filled objects (rectangles, round rectangles, and ovals) are
drawn.  If none of the polygon edges falls behind a filled object, MGPU is significantly faster if No is selected.

Edges controls how the edges of objects (lines, rectangle edges…) will be drawn.  WYSIWYG provides the line
widths specified in the original after they have been expanded into the plot area.  This option is suitable for high
quality presentations.   # Traces yields a medium quality drawing suitable for engineering plots;  bold lines will
appear bold but some fills will not fill to the edges.  Single is suitable for fast plots as all edges are drawn only once.



Plotter Page

Plotter Page displays the maximum plotting area on the selected plotter by drawing rulers and marking the limits
with a darkened ruler marking.  The current plotting area for the current selection is displayed as a rectangle with
handles.

The size of the rectangle may be changed by dragging the handles, however, it will always maintain the aspect ratio
of the selection rectangle.  The four arrow boxes are ‘tiling’ controls which allow the plotting rectangle to be moved
to the adjacent area without resizing.

To illustrate tiling, select the lower right corner of the plotting rectangle and reduce to about one inch wide.  Now
select the tiling controls and observe the resulting plotting rectangle.

Selecting OK will update the plotting rectangle and return to the previous graphic; selecting Cancel will exit without
changing the plotting rectangle.



Scaling

Scaling allows the selection of automatic or
manual scaling and displays the sizes of the
selected area, the plotting area and the maxi-
mum paper size.

Automatic selects the largest available
rectangle on the plotter paper of the same
shape (i.e. same aspect ratio) as the selected
graphic area to be plotted.  Manual uses the
values of Document Inches and Plotter Inches
to control the scaling while preserving the
aspect ratio.

Document Inches and the Selected Area are
given in 72nds of an inch as this is the pixel
size on the Macintosh screen.  Plotter Inches,
Plot Area and Paper Size are given in 1000ths
of an inch as this is the smallest addressable
unit on most plotters.

If the numbers for manual will not fit on the
current paper size, MGPU will switch to
automatic and display an alert.

Select OK to continue.

Click here for a discussion of this error.



Resolution

MGPU draws curves using straight line segments.  The first three parameters control how many segments are used to
draw the curved portions of these kinds of objects.  For example, full size circles (i.e. the circle covers the entire
plotter page) are represented using 1536 points around the circle: 1/1 means to use every point; 1/2 means to use
every other point;   1/4 means to use every 4th point; etc.

Smaller curved objects can be drawn with the same smoothness using fewer segments than the full sized object.
Shrink Adjust controls how many fewer segments are used for these smaller objects.  For a circle covering 1/2 the
plotter page, 1/2 the value specified for Ovals & Circles would be used.  This shrinkage is limited by the Shrink
Adjust value; for 1/8, circles smaller than 1/8 of the plotter page would be drawn with 1/8 of the number of segments
specified for a full circle.



Smaller curved objects can be drawn with the same smoothness using fewer segments than the full sized object.
Shrink Adjust controls how many fewer segments are used for these smaller objects; it specifies the minimum num-
ber of points to be used.  For example, choosing 1/8 will tell MGPU to always use as a minimum 1/8 of the number
of points of a full size object.  MGPU will often use more than this minimum number of points.  If Shrink Adjust is
set to 1/8, an object larger than 1/8 of the plotter page will be drawn with the number of points proportional to its
size; a circle covering 1/2 of the plotter page will be drawn with 1/2 the number of points of a full size object on the
plotter page.  Objects smaller than 1/8 size will all be drawn with 1/8 the number of points of the full size object..

Plotter Ratio specifies how much of the plotter resolution is used by MGPU.  Many of the plotters supported have
1000 points/inch resolution, however the pen point diameter degrades the actual resolution on the paper.  Most
Macintosh drawings are specified using the screen with 72 points/inch.  If object intersections are calculated at 72
points/inch and drawn at 1000 points/inch, a gap will show at the intersection if the pen point is relatively narrow.
With a Plotter Ratio of 1/4 (i.e. 250 points/inch) the gap will be filled by most pens.  1/1 will do all calculations at
1000 points/inch and curved object intersections will be slower.

The fastest plot is obtained using the smallest values; however, short arcs can be lost in these coarse settings.  The
slowest, smoothest is obtained by using the largest values.  Values in between will give good quality plots in a rea-
sonable time.

These values are saved with Save Settings As… and restored with Open Settings… from the File menu.



Color

Color provides the facility for adding (or modifying) color to MacPaint and Pict documents.  For Pict documents,
color and patterns may be specified for objects which may be distinguished by pattern, color, or type.  For MacPaint
documents, ten color rectangles are provided for color control.  The Tips… section suggests ways of creating draw-
ings with MacDraw, SuperPaint, and MacDraft so that color may be easily added with MGPU, the Mesa Graphics
Plotter Utility.



Color for Pict Documents

If Color is selected while a Pict document is being displayed;



A pattern menu, a line type menu, a pen/color menu, and object data are displayed.

Current Selected Pattern                                  Pattern Menu                          Line Type Menu

Object Data                                                            Pen/Color Menu

The pattern menu shows several patterns and the current selected pattern.  The current selected pattern may be
changed by selecting another one from the pattern menu by moving the arrow with the mouse to the desired pattern
and pressing the mouse button.



The line type menu allows the choice of six line types which are plotter dependent (see your plotter documentation);
1 is always solid and 2-6 are various line patterns, long dash, short dash, dash dot, and etc..  The current line type
selection is highlighted and may be changed by moving the arrow to another and pressing the mouse button.

The pen/color menu shows the pen number and the assigned color with the current selected pen highlighted.  To
change the current pen, move the arrow to another and press the mouse button.  Pen number 9 (None) is always
present; objects with this pen color are not plotted on the paper.  Check that the pens in your plotter correspond to the
colors in the pen/color menu.

The first two columns of the object data show what pattern and color were active when the particular object was
created.  The third column shows the type of the object; line, rectangle edge, etc.  The fourth column shows the
pattern which will be used when plotting the filled areas or what line type will be used when plotting the lines or
edges; 1 is always a solid line, 2-6 will be various kinds of dashed and dotted lines depending upon your plotter.  The
fifth column shows what color will be used when the object is plotted.

Colors may be changed for all objects, but patterns may be changed only for fill objects.  Fill patterns may be
changed to any pattern in the pattern menu.  Plotters do better on line patterns rather that shades of gray and only
“good plotter patterns” are included in the pattern menu.  Note that for text, only the color can be changed.

Next and Previous provide for scanning the object data, in groups of ten,  to locate specific entries.

At any given time, the arrow contains three attributes; the current pattern, the current line style, and the current pen/
color.  To change these current attributes, move the arrow and click on the desired attribute.



For example,  change the pen pattern to diagonal lines, the line style to type 2,  and the pen/color to red.



To distribute these new arrow attributes to objects, move the arrow over data in the last two object data columns (i.e.
columns 4 and 5) and click the mouse button.  The line type, the pattern, or the color will be changed to the appropri-
ate current attribute; a beep indicates an illegal change has been requested.

In this example, several patterns, line types, and colors are changed.

Clicking OK will accept the current values and return to the graphic display.



Using a Previously Defined Color Table with a Pict Graphic

As you work with a Pict graphic:

• You modify it with MacDraw or MacDraft…
• Restart MGPU and read the new Pict graphic
• Reset the color assignments

This continual resetting of the color assignments for modified or similar graphics is boring and unnecessary.

When the color assignment is satisfactory, use Save Settings As… from the File menu to save the current settings;
the color assignments are saved in the Settings document.

When you want to use a previously saved color assignment, FIRST DEPRESS THE
<Option> KEY AND THEN SELECT Open Settings… from the File menu, select the appropriate Settings docu-
ment and these color assignments will replace the ones for the current Pict graphic.

Appending to a Current Color Table with a Pict Graphic

Whenever a new Pict graphic is selected via Paste or the Open Graphic… command, a new color table is con-
structed by analyzing this new graphic.  If you want to use the current color table and only append different new
objects to it, then FIRST DEPRESS THE <Option> KEY AND THEN SELECT Open Graphic… from the File
menu, select the appropriate graphic document and the new objects will be appended to the color table; if pasting,
FIRST DEPRESS THE <Option> Key AND THEN SELECT Paste from the Edit menu.



Color for MacPaint Documents

If Color is chosen while a MacPaint
document is being displayed,



a pen menu with pen numbers and colors is displayed, with the current pen highlighted.  The current pen color can be
changed by selecting a new color using the mouse.

When the user selects New Color Rectangle, a rectangle appears with the current pen number as a tab, as illustrated.



This rectangle may be moved and sized to outline an area to be plotted with that color.



The technique is to use a maximum of ten color rectangles to outline different areas and then to plot all of these rec-
tangles at once, as illustrated.

If the desired image cannot be divided by rectangles, use MacPaint to generate different documents for different
colors and use MGPU to overlay these documents to the same plotter page.



Changing Colors in MacPaint Documents

The color tab of a color rectangle may be changed by selecting the new color, positioning the arrow over the tab of
the rectangle to be changed, and clicking the mouse button.

Removing Color Rectangles

A color rectangle may be removed by choosing Color from the Settings menu while a MacPaint document is being
displayed.  Move the unwanted rectangle to the right of the MacPaint graphic.  All color rectangles which do not
enclose part of the MacPaint page are deleted when OK is selected.



Customizing the Mesa Graphics Plotter Utility

Most of the customizing of MGPU for a particular plotter and standard color assignments are provided via the Save
Settings As… and Open Settings… commands.  However, there are several editable types in MGPU’s resource file
which can be modified by a resource editor; e.g. ResEdit from Apple.

Patterns in the Resource

The 24 patterns in the pattern menu for the color assignment for Pict documents are in the resource file as a pattern
list (PAT#) with id 100.  These can be changed to whatever patterns are desired.

Plotter Information in the Resource

The number of pens and the coordinate range for the four paper sizes for each supported plotter are read from
MGPU’s resource file and may be edited by a resource editor (ResEdit from Apple).  They are string lists (STR#) and
their id’s are in the 600’s.  The data organization is:

number of pens (max 8)

small-wide minimum x coordinate
minimum y coordinate
maximum x coordinate
maximum y coordinate

large-wide minimum x coordinate
minimum y coordinate
maximum x coordinate
maximum y coordinate

small-tall minimum x coordinate
minimum y coordinate
maximum x coordinate
maximum y coordinate



large-tall minimum x coordinate
minimum y coordinate
maximum x coordinate
maximum y coordinate

page type (1=small only, 2= small & large, 3=auto)
query type (1=none, 2=Hewlett Packard,

3=Houston Inst)
fast pen speed command
medium pen speed command
slow pen speed command
line type one command
line type two command
line type three command
line type four command
line type five command
line type six command
plotter name/model



Off

1
0

1
0

Plotters

All plotters are driven from MGPU via a serial port, 9600 baud, full duplex, no parity, 8-bits (with the upper bit zero
also called space parity), one start bit, one stop bit,  and DTR hardware handshaking.  Any plotter connected to
MGPU must support and be set for these parameters.  Make sure that you set the options for the plotters as follows:

Apple 410

Cable: Type 1 Switches:
Notes: Both green indicators must

 be on to plot. A & B sizes.

Hewlett Packard 7470A

Cable: Type 1 Switches:
Notes: A size only

Hewlett Packard 7475A

Cable: Type 1 Switches:
Notes: A & B Size

Hewlett Packard 7550A

Cable: Type 2
Notes: A & B Size
Connector: Computer
Data Flow: Remote
Handshake: Hardware Direct

Bypass: Off
Duplex: Full
Baud: 9600
Parity: 8 bits off

Note: Select Other HP or HP7475A for Model in Plotter Settings



Hewlett Packard ColorPro

Cable: Type 1 Switches:
Notes: A  size only

Hewlett Packard DraftPro

Cable: Type 1
Switches:

Standalone
Baud 9600
Parity Off

Even (causes space parity)
Connector: Computer/Modem

Note: Select Other HP for Model in Plotter Settings

1
0

Hewlett Packard DraftMaster

Cable: Type 1
Settings:

Expand: Off
Serial: Dataflow Remote Standalone

Baud 9600
Parity 0

Bypass Off
Duplex Full
Monitor Mode Off
Auto Disconnect Off

Connector: Computer/Modem

Note: Select Other HP for Model in Plotter Settings



Houston Instruments DMP29

Cable: Type 2 Switches:
Notes: A & B sizes
Connector: Modem

Houston Instruments PC695 (& 595)

Cable: Type 1 + Special DB25(F) Switches:
Black -DB25-2
Red -DB25-3
Green -DB25-7     1  2  3  4   5   6
Yellow -DB25-20

Notes: A & B size (595 A only)

Houston Instruments DMP41 or DMP42

Cable: Type 2
Notes: C & D sizes

Must be set to 9600 baud from front panel after each power on. Set up like
the DMP51 or DMP52; select DMP41/51 or DMP42/52 for Model in Plotter Settings.

OPEN

Houston Instruments DMP51, DMP52, DMP56, DMP61,
DMP62

Cable: Type 2
Notes: C & D sizes
Pen Change Action: Ignore
Addressing: .001 IN
Character Set: G0

Text Font: F0
Baud Rate: 9600
Uart Parity: Bit8=0
Handshake RTS/DTR: Toggle

Note: Select Other Houston for Model in Plotter Settings for the DMP56,
DMP61, and DMP62.



Cables

 Plotter Cables

Mac 512, or Mac Plus
Enhanced SE, II

Type 1 Imagewriter I cable Mac Plus Cable Adapter (M0189)
+ Imagewriter I cable

or

Custom cable from Mesa Graphics

Type 2 Type 1 + gender changer Type 1 + gender changer



Connector Pin Outs

5 4 3 2 1

9 8 7 6

Mac 512K, 512KE Serial Connectors

1 Ground
2 +5 volts
3 Ground
4 Transmit data +
5 Transmit data -
6 +12 volts
7 Handshake/external clock
8 Receive data +
9 Receive data -

8 7 6

12

5 4
3

Mac Plus, SE, II Serial Connectors

1 Output handshake
2 Input handshake/external clock
3 Transmit data -
4 Ground
5 Receive data -
6 Transmit data +
7 Plus(not connected)

SE, II (GPi general purpose input)
8 Receive data +



Using NetSerial

Installing NetSerial Hardware and Software

Follow the installation instructions in the NetSerial documentation for the NetSerial hardware and software.  After
the NetSerial software is installed, it will appear in the Control Panel and Chooser desk accessories.  The hardware
should be installed as illustrated.

Plotter

AppleTalk
System
Connector

AppleTalk Network

Net Serial   



Setting Up NetSerial

The NetSerial software normally releases the NetSerial hardware after two minutes of inactivity.  With MGPU, this
time out should not be used.  Thus, choose Control Panel from the  menu;

then, select NS Prefs as illustrated.



Click on Don't Auto-Release and then click
on the close box.

The NetSerial software is now properly set for
use with the Mesa Graphics Plotter Utility.



NetSerial Options

Once the NetSerial software is installed, MGPU will
try to connect to it if you have selected the port to
which the NetSerial is installed.  Upon successful
connection, the NetSerial icon will appear in MGPU's
menu bar.

If NetSerial is not available, a warning dialog box will appear.

 If you click Get When Available, another dialog box will notify you when it is available.



If You Have a Problem

If MGPU cannot access NetSerial, most problems can be corrected by releasing NetSerial and then reassigning it.

To release NetSerial, choose Plotter from the Settings menu, click on the connecter which is not associated with
NetSerial (usually the modem port-i.e. the one which is not connected to your AppleTalk network), and click on OK.
The NetSerial icon in the menu bar should disappear.

To reassign NetSerial, choose Plotter from the Settings menu, click on the connecter which is associated with
NetSerial (usually the printer port-i.e. the one which is connected to your AppleTalk network), and click on OK.  The
NetSerial icon should appear in the menu bar.



Glossary

Apple menu:  The menu on the far left in the menu bar, from which you choose desk accessories.
It is denoted by  .

application:  A computer program that lets you manipulate certain kinds of information for a certain purpose, such
as drawing, communications, etc.

attributes:  Color, fill pattern, and line type are the three items which MGPU allows to be changed and plotted.

baud rate:  The speed of serial communications in bits per second.

click:  To position a pointer or cursor using the mouse, then press and quickly release the mouse button.

color tab:  The numbered tab on color rectangles indicating which pen will be used when drawing data in this rec-
tangle. (for MacPaint docments only)

connector:  The sockets on the back of the Macintosh into which the peripherals are attached; the mouse, printer, etc.
The peripherals may also have connectors; cables are used between connectors.

desk accessories:  Applications that are available from the Apple menu.

desktop:  Macintosh’s environment; the menu bar and the area below on which the icons appear.

dimmed items:  Options which appear dimmed in menus and cannot be selected.

document:  Whatever you create with applications which can be saved and manipulated by the application or other
applications.  An icon is associated with a document and is displayed on the desktop.

double-click:  Two quick presses and releases of the mouse button.

drag:  Position the cursor on an object, press and hold the mouse button down.  The object will be dragged across the
screen as the mouse is moved.  Release the button when the object has reached the final location.
DTR:  A hardware handshake protocol used by computers and terminals to control the communications to prevent
the loss of data when one is busy.



error message:  A message which is displayed on the screen which notifies the user that “all is not well” and may
require user intervention.

fill pattern:  That arrangement of black and white pixels which will be used to fill in an area on the screen.

full duplex:  Indicates that each partner in the communications expects the other to echo the data sent.

handshake:  A set of rules or protocol for computers to communicate in which each agrees how it will act when it
cannot handle any more data.  In MGPU , all plotters are driven using hardware rules (DTR handshaking).

icon:  A graphic representation for something else.

line type:  The different kinds of lines which plotters can draw; solid, dashed, long dashed, etc.

menu:  A list of commands from which you can select one using the mouse.

menu bar:  The horizontal strip at the top of the Macintosh screen.

object data:  A listing of the contents of Pict data showing the object type, color, and pattern.

opening:  Reading the data in a document; results in altering the behavior or in a new graphic display on the screen.

overlay:  The technique of plotting several MacPaint documents into the same area on the plotter paper.  Overlaying
is not recommended for Pict documents.

Pict:  A data format in which the object descriptions are stored so that when the data is drawn to a different scale, the
graphic can be drawn correctly.  Results are high quality on high quality devices, such as the LaserWriter and plot-
ters.

plotter page:  A command in the Settings menu which displays the plotting area and allows you to change its size
and location.

plotter settings:  The parameters which control the pen plotter; the menu which provides access to these parameters. 
The parameters include model, speed, paper size, etc.



plotting rectangle:  A rectangle displayed when Plotter Page is chosen from the Settings menu;  indicated the size
and location of the plotter paper allocated for the next plot.

save:  To store information on a disk for later use.

selection rectangle:  A rectangle enclosing the items in the graphic which have been chosen or “selected” for plot-
ting.

settings document:  The MGPU  document which contains all of the parameters which customize MGPU  for an
individual user.

scaling:  A command in the Settings menu which allows precise setting of the scaling parameters to be used when
transferring the screen graphic to the plotter paper.

tiling:  The technique of covering an area with tightly packed rectangles as in tiling a floor in your home.  In MGPU ,
tiling is a technique of selecting the data in the adjacent rectangle with a perfect joint between the rectangles, or tiles.
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